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Definitions  
Agency eCivis User – A user of eCivis Grants Network. This is a State of Indiana staff 
person using the system as a Grantee or Grantor. See Grantee and Grantor.  

Application Workspace – An Application Workspace is created for authorized Agency 
eCivis users to view and create their application and evaluation forms outside of any 
State of Indiana required fields for competitive solicitations It will also include the budget 
selected at solicitation, but it is not editable. The Application Workspace allows Agency 
eCivis users to identify application review team members, make application review 
assignments, and tabulate review results and scores. See also Solicitation and Zengine. 

Cash Match – A portion of project costs not paid by Federal funds as a direct project 
expense (2 CFR 200.306). This portion of the project costs are provided as cash from the 
Indiana State Agency or State of Indiana resources. 

eCivis – The software vendor that created eCivis Grants Network (Indiana State 
Agencies as Grantees/Grantors) and eCivis Grants Portal (Applicants/Subrecipients to 
Indiana State Agencies’ grant programs). 

eCivis Grants Network – The grant management system created by eCivis for state 
Grantees/Grantors. 

Evaluator – The person responsible for reviewing and evaluating a grant application. An 
Evaluator may be a State of Indiana employee or an external party (non-State of Indiana 
employee). Reviewers do not need to have an eCivis Grants Network license/account. 
Also referred to as a Reviewer or Peer Reviewer. 

Grantee – Persons or organizations who receive funding from another party. Indiana 
State Agencies operate in the role of a Grantee when they receive funding from external 
parties like the Federal government. A Grantee is also referred to as a Subrecipient.  

Grantor – Persons or organizations that provide grant funding to another party. Indiana 
State Agencies operate as Grantors when they distribute grant funds to Subrecipients 
(Grantees). Also, referred to as a Funder.  

In-Kind Match (Third-Party In-Kind Contribution) – The value of a non-cash 
contribution (i.e., property or services) that—(1) benefit a Federally-assisted project or 
program; and (2) are contributed by non-Federal third parties, without charge, to a non-
Federal entity under a Federal award (2 CFR 200.1). 

Notice of Funding Opportunity (NOFO) – A formal announcement of the availability of 
funding through a financial assistance program from an awarding agency. 

Program Manager – An Agency eCivis user that is the first Agency eCivis user to set up 
a Grantee project or solicitation (Grantor). 

Reviewer – See Evaluator. 

Reviewer Portal – The eCivis Portal Evaluators will log in to access their assessments 
and application reviews. 

https://www.ecfr.gov/current/title-2/subtitle-A/chapter-II/part-200/subpart-D/section-200.306
https://www.ecfr.gov/current/title-2/subtitle-A/chapter-II/part-200/subpart-A/subject-group-ECFR2a6a0087862fd2c/section-200.1


 

3 
 

Solicitation – The public-facing notification of available grant funding. The solicitation 
setup in eCivis Grants Network creates either public-facing or internal content, dependent 
upon program-specific settings. See Notice of Funding Opportunity (NOFO). 

Workspace – See Application Workspace and Zengine. 

Zengine – The third-party tool used for the configuration of online applications, 
application review forms, assignment of reviewers to applications, and online review and 
scoring of submitted grant applications. This is also referred to as the Application 
Workspace. 
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Purpose 
The purpose of this user guide is to provide instructions to State Agencies on the eCivis 
reviewer functionality. Agency eCivis users managing a program solicitation with 
applications will utilize these features. 

Step 1: Reviewer Portal After Publishing Grant Program 
After emailing support@ecivis.com to publish a grant program, an email will be sent 
notifying the Agency eCivis user of when the grant program is available. This email will also 
include a link to access the reviewer portal. Once reviewers and their corresponding 
applications are assigned, the provided Reviewer Portal link can be distributed to begin the 
evaluation process. 

Step 2: Adding or Removing Reviewers 
1) On the eCivis Grants Network homepage, the Agency eCivis user will select 

Subrecipient Management from the dropdown menu in the Grant Management tab. 
 

 
 

2) In the Subrecipient Management page, navigate to the Program Solicitations table at 
the bottom of the screen. In this table, click on the appropriate title of the program 
solicitation that requires reviewer modification. 

 

 
 
3) In the appropriate program page, click Edit Solicitation. 

 

mailto:support@ecivis.com
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4) Click on the Review tab. This is the page where the Agency eCivis user can add or 
remove reviewers. 
a. In this tab the Agency eCivis user can add reviewers by clicking the Add Reviewer > 

button  . This will prompt a form to appear. In this form, the Agency eCivis 
user will be asked to enter the reviewer’s First Name, Last Name, and Email. Once the 
reviewer’s information is entered, click the Add Reviewer >button . 

 

 
 

 
b. To remove reviewers, navigate to the Review Committee box. Next to each reviewer 

is the Delete icon ; clicking on it will remove the reviewer on the corresponding row. 
c. To populate the Reviewers section in the Zengine Workspace, the Agency eCivis 

user who set up the solicitation should input their information to be the first reviewer. 
 

 
 

5) After modifying reviewers, click the Save > button  at the bottom of the Review tab. 
 
6) The modifications performed here will be automatically imported into the Zengine 

Workspace. 
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Step 3: Assigning Applications to Reviewers 
The Zengine Application Workspace will need to be accessed to manage application 
assignments to reviewers. 
 
1) Enter the corresponding Zengine Application Workspace for the appropriate program. 

Click on Application Workspace to enter the Zengine Workspace. 
 

 
 
2) In the new screen, notice the banner icons at the top of the screen. Click the Program 

Mgr & Assignments icon , which denotes the Program Manager feature.  
 
3) On the following page, click the Edit Assignments button . 
 

 
 
4) The Agency eCivis user can make assignments by Submission, Submission Group, 

Member, or Batch Assign. 
a. Assign by Submission 

• This is a manual assignment based on an application submission. The Program 
Manager (Agency eCivis user that first created the solicitation and Zengine 
Workspace) selects a Submission and then clicks Assign to add a single 
reviewer to the assignment list.  

b. Assignments by Submission Group  
• This is a manual assignment based on a previously created submission group. 

This submission group can include multiple reviewer team members and can 
have a specified reviewer workflow. The Program Manager can then select a 
submission group and then click Assign to add members within that group to 
the assignment.  

c. Assign by Member 
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• This is a manual assignment based on the review team member. The Program 
Manager selects a Member and then clicks Assign to add a single Submission 
to the assignment list.  

d. Batch Assign 
• This is a random assignment based on criteria specified in the batch assignment 

process. The Program Manager must specify whether these random assignments 
will be made based on the submission, member, or submission group. Then input 
the number of entries that will be assigned and choose to limit these assignments 
to specific reviewers. Once this information is provided click Assign.  

 

 
 
Step 4: Reopening a Review 
This step will be managed in the Zengine Application Workspace. 
 

1) To reopen an application assessment, which covers a review of the application 
responses and reviewer scoresheet, click on the Review tab (via the Data icon ). 

 

 
2) In this screen, all reviews regardless of status (not started, in progress, or submitted) 

are shown. Select the review that needs to be reopened or changed. 
 

 

3) In the selected review screen, there is an option to return the review to draft status. 
Clicking on the folder and selecting “In Progress” or “Not Started” will revert the review 
to draft status. 



 

8 
 

 
 

Step 5: Review Feedback & Scores 
There are two forms where Agency eCivis users can check other reviewers’ application 
feedback and scores. 

1) In the Forms tab, click on the Reviews header at the top of the screen. This form 
contains the feedback and category scoring submitted by the reviewer for each 
application they were assigned. 

 
 
2) The default view groups reviews by status (not started, in progress, or submitted). 

However, this can be regrouped by application and by reviewer. To change the Agency 
eCivis user’s view, click on the View dropdown menu and select the desired view. 

 

 
 
3) In the Reviews tab, the Applicant’s total score will be shown in the Total Score column. 

The bar at the bottom can be used to scroll left and right to display more information. 
Each view in Zengine Workspace can also be edited by clicking the vertical lines icon . 
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4) Views in Zengine Workspace can be saved by clicking save as new view. 

 

 
5) Upon clicking save as new view, a new screen will appear to confirm.  

Click the Save button . 

 
6) Saved views can be accessed by clicking the View box. 
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7) The second form to review is the Applications tab. Here each applicant’s average 
score is included at the bottom of each record. As a reminder, the bar at the bottom 
can be used to scroll left and right to display more information. 
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Step 6: Bulk Emails 
In Zengine, the Bulk Email functionality is optional and can be used to specify a list of 
recipients to send an email directly from the system. The Budget Agency does not 
recommend using this feature to email and inform applicants of their final award 
decisions, as necessary documentation an agency should provide an individual applicant 
regarding the decision would not be included.  
 
For instances aside from award decisions that a bulk email could be useful: 
1) The Agency eCivis user will navigate to the homepage and hover over Grant 

Management and click on Subrecipient Management. 

 
 

1) In the Subrecipient Management page, navigate to the Program Solicitations table at 
the bottom of the screen. In the Actions column for the program select View Detail. 

 

 
 

2) On the Program Detail page click the Application Workspace button . 
 

 
 

3) The Agency eCivis user will navigate to the program’s Application Workspace.  
On the banner click the Bulk Email button  to navigate to the Bulk Email feature. 
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4) The Bulk Email page will appear; click the New Email button .  
 

 
 

5) A draft email form will appear. Begin creating the email by locating and specifying the 
recipient(s). Click and edit the following fields to create a draft email: 
a. Recipients Form: Click the dropdown menu and select the form that contains the 

recipient’s email information.  
b. Email Field: Click the dropdown menu and select the field that contains the correct 

email address. 
c. Filter Recipients: Click this button to filter the recipient list based on specific criteria. 

 
 

 
d. Example: If this bulk email is intended only for denied applications, use the 

dropdown menus to set the criteria as follows:  
• Field – Folder 
• Condition – Is 
• Value – Denied  

 

 
6) The next section of the email specifies who the email is from and its contents. 

a. From Name: Enter the name of the individual/organization that will appear in the 
recipient’s email. 

b. Reply To: Enter the email address of the individual/organization who will be 
receiving responses. 
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c. Send To: This is an automated field that shows the number of recipients that match 
the previously selected filter criteria.   

d. Subject: Enter the subject line for the email; additionally, an Insert Field option will 
be given to pull in data from a previous form. 

e. Body: Draft the email message and subject line; utilize the Insert Field option to 
pull in data from a previous form.  

 

 
 

7) Once the bulk email is drafted utilize the following options to proceed: 
a. Preview : Click this button to look at a preview of the email before sending. 
b. Schedule Email : Click this button to schedule a specific date and 

time for the email to be sent.  
c. Send Now : Click this button to send an email immediately. 

 

 
 
8) Once the bulk email is sent it will appear in the Sent tab of this section.  
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Step 7: Reviewing Awards and Denials 
1) Agency eCivis users can review their program solicitation awards and denials in two 

locations. 
 

2) The Zengine Workspace of the program solicitation will list all received applications. 
Click Filter on the Status column to filter by awards and denials. A new filter screen 
will appear. Select “Folder” in the Field dropdown and select either “Denied” or 
“Awarded” in the Value dropdown. Combine both filters with an “and” logic and this will 
list all applications that have been awarded or denied. 

 

 

 

 
 

3) Awarded applications are also displayed in the program solicitation’s Program Detail 
page. Under the Subrecipient Awards table, all subrecipients in the program 
solicitation are listed. This is also the table in which Agency eCivis users can interact 
with individual subrecipients. 

 

 
 

Conclusion 
After awards or denials have been issued, the Agency eCivis user can manage those 
subrecipients awards through the SOI User Guide - Grantor 4. Managing Subrecipients. 
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